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 5.  DRAWING CROSS-SECTION GEOMETRY

5.1.  Overview of Drawing a Cross Section
You can start drawing a cross section in THERM using either of two approaches:

� Import a DXF file or a bitmap file as an underlay. Then, use the DXF file autoconvert feature or trace the
underlay using a mouse.

� Work from a dimensioned drawing and use the “step size” function and arrow keys to specify the cross-
section dimensions and draw the elements.

In general, the subsequent steps are the same whether you trace an imported file or start from a dimensioned
drawing:

1. Draw polygons and rectangles to represent the cross-section geometry (for more details, see Sections 5.4-
5.5). When modeling windows, we recommend that you import a glazing system from the WINDOW
program (see Section 5.9), but you can also represent the glazing systems with individual rectangles
(recommended only for advanced users).

2. Assign materials to polygons and rectangles as you draw (recommended) or after the drawing is
completed (see Section 5.10). Use the THERM default material library to model solids or frame cavities
and to define new materials as necessary (see Section 5.11).

3. Add, delete, or move polygons and points as necessary (see Section 5.6).

4. Insert a glazing system created in WINDOW. Glazing systems from WINDOW are imported into
THERM with all material properties, including the effective conductivity of the glazing cavity and
boundary conditions, automatically defined (see Section 5-9). Use of the Condensation Index Model
requires that the glazing system be imported from WINDOW (see Section 5-9).

When you have finished these steps you are ready to go to Chapter 6, "Defining Boundary Conditions."

The following sections explain in detail how to draw cross sections with or without an underlay.

5.2.  Importing a DXF or Bitmap File as an Underlay
THERM reads and interprets DXF and bitmap formatted files, which simplifies the process of creating
thermal models.

� DXF Files:  A DXF (drawing exchange format) file is an export format supported by many CAD and
graphics programs. When you export DXF files from another program, it is best to keep them simple,
eliminating elements such as text, shading, and dimensions that are not needed for the thermal model.
Section 5.2.3 provides suggestions on how to make a DXF file for use with THERM. A DXF filter function
(see Section 5.2.2) in THERM can be used to restrict what entities (points, polylines, and arcs) are
included in the underlay. Using an imported DXF file has the following advantages:

� Autoconvert:  Closed polylines and curves are automatically converted into polygons.

� Snap to Underlay:  When tracing an underlay, the cursor will automatically snap to the underlay
vertices, making drawing fast and accurate.  Section 5.3.3 discusses Snap Settings, which govern how
THERM decides where to snap.
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� Bitmap Files:  THERM can also import bitmap files (files with a BMP extension), made, for example by
scanning a drawing or capturing a screen from another drawing tool.  However, BMP files do not contain
information about points or lines, so THERM cannot perform autoconvert or “snap” to the bitmap
underlay as with DXF files. It is often easier to work from a dimensioned drawing than to try to get the
correct dimensions by tracing a bitmap underlay.

Use the following steps to import a DXF file to use as an underlay for your THERM drawing:

� Select Underlay from the File menu.

� Select the DXF or bitmap file name from the Underlay dialog box.

5.2.1.  Select Underlay from the File menu

Figure 5-1.  To import a DXF file, pick the Underlay option from the File menu.

5.2.2.  Select DXF or Bitmap File

1. The Underlay menu choice will bring you to the Underlay dialog box.

Figure 5-2.  The Underlay dialog box

2. Click on the Browse button to see all files in your current working directory with a file extension of *.DXF
or *.BMP.
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Figure 5-3.  Click on the Browse button to get to the Open dialog box.

3. Highlight the desired file and press the OK button, which will bring you back to the Underlay dialog
box.

Figure 5-4.  Select the DXF file using the Underlay dialog box.

Options you may want to set in the Underlay dialog box include:

� Scaling:  Scaling inputs allow you to change how THERM scales the imported underlay in both
horizontal and vertical directions.  This feature is usually used only for BMP files.  If you change the
horizontal value, the vertical value will automatically change to match it, but you can then change the
vertical value and the horizontal value will not change.  The default values are 100% in both
directions.  For DXF files, use the program default value of 100% unless the DXF file is not 1:1. Make
sure the Units value is set to match the system that the DXF file was drawn in. The default is IP, so if
you are using an underlay created in SI units, make sure you switch this value.

� Autoconvert:  This feature converts closed polylines and curves into polygons. If a DXF file is
exported from a drawing made up of closed polylines, THERM can automatically convert the
drawing into polygons. The polygons will have the currently selected material property. If the DXF
file is exported from a drawing made up of lines or open polylines, THERM will not be able to
convert the drawing to polygons. You can always try to use the Autoconvert feature by checking the
box and seeing what happens. If THERM does not find any polylines, it will not generate any
polygons. Make sure to check the polygons generated by THERM. A common problem is
overlapping polygons; polygons are sometimes completely hidden underneath other polygons. Use
View/Show Voids/Overlaps (see Section 5.3.5) after using the Autoconvert feature to check for
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overlapping polygons. See Section 5.2.3 for a more complete discussion on how to make DXF files
that THERM can correctly autoconvert.

With autoconverted DXF files, curves are converted into a series of straight line segments at a degree
specified by the user. The default value for this division is that every 15o of arc is converted into a line
segment. This value can be changed using the Options/Preferences menu choice, by entering a
different value in the Arc to Polygon conversion input box on the Drawing Options tab. It is
recommended that you do not over specify curves.

� Underlay Origin:  This box indicates the underlay’s x and y coordinates relative to the THERM
origin.  These coordinates represent the position of the lower left corner of the underlay; their values
default to 0,0.

� Set Color:  This button allows you to set the color of the underlay as it will appear in your drawing
area.  If you have a color monitor, this feature allows you to differentiate the underlay from other
drawing components.

� DXF Filter:  This button leads to another dialog box where you can indicate which elements you want
THERM to import from the DXF file.  This feature is used to eliminate unnecessary elements in the
DXF file.

Figure 5-5.  The DXF Filter dialog box

When you import an underlay to THERM, the program will zoom the drawing to fit in the drawing area.

The following two figures show a DXF file drawn with polylines that THERM can interpret.  Figure 5.6 shows
the underlay without Autoconvert, and Figure 5.7 shows the same underlay imported with Autoconvert
turned on. The underlay in Figure 5.6 can be traced when drawing the polygons; in Figure 5.7, the polygons
already exist.
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Figure 5-6.  A DXF file imported as an underlay with Autoconvert turned off, so no polygons are drawn

Figure 5-7.  A DXF file imported as an underlay with Autoconvert turned on, so closed polylines are converted into polygons

THERM only allows one DXF file at a time to be associated with a model. If you want to use multiple DXF
files, first remove the existing file using the File/Underlay menu choice, and press the Remove button. You
can then import a new underlay.

Once you have finished working with a DXF file, you can use the View/Underlay menu choice to hide the
underlay; the underlay view is off if there is not a check mark to the left of the menu choice. Although you
cannot see the underlay, it is still associated with the model until you remove it using the method discussed
above.
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5.2.3.  DXF File Conversion

The DXF file underlay feature in THERM allows you to create simulation models quickly and accurately.
With this feature, you can export a drawing created in a computer drafting program using a DXF file format
that can be read by THERM and automatically converted into polygons.

You can take many steps when creating your drawing and DXF file to simplify the process of using the DXF
file with THERM.  These modifications can be made after a drawing is created in the drawing program but
will be most efficient if they are incorporated into standard drawing practices.

When you make your drawings:

� Put dimensions and shading on different layers from the main drawing.  When you export the DXF file,
turn off these layers, so the underlay will not be complicated with information that is not needed for the
thermal analysis.

If you want to use the THERM DXF Autoconvert feature:

� Use closed polylines when creating your DXF file. THERM can autoconvert DXF files that have the cross-
section elements drawn as closed polylines.  A drawing can be converted to closed polylines by using
commands such as Boundary in AutoCAD™.  This feature works very well with straight-line drawings
but is somewhat unpredictable with polylines that contain curves.

� You can use AutoLISP programs that clean up drawings by creating closed polylines and deleting
duplicate entities. In AutoCAD™, this can also be done by hand using the Trim, Extend and Delete
features.

� Modify the cross section to break up places where a polyline intersects itself. THERM does not draw
regions that have multiple connections (i.e., donuts). Make this modification while the object snap is set to
ensure that these line segments intersect existing lines. Line segments can be drawn on a separate layer
that can be turned off when the drawing is used for non-THERM purposes.

� Test the DXF file import  into THERM; if THERM has difficulty picking up some details of the drawing,
exploding the DXF file may help. Unfortunately, once closed polylines are exploded, they cannot be
autoconverted.

When you Export the DXF file:

� Only export the elements in the DXF file that are needed for the thermal analysis.  For example, in
AutoCAD™, you can use the “object” option of the dxfout command and select only the items that you
want to export. This eliminates extraneous elements in your DXF files, such as extra views of the drawing
or elements that were deleted but remain in the database.

� DXF files are often in the form of assembly drawings, so snap-in pieces are usually not placed accurately,
and deformable pieces are usually drawn as overlapping entities in their nondeformed state.  These
features make an assembly drawing difficult to use in THERM.  It is easier to create a THERM model if
you provide the parts unassembled in one or several DXF files and then assemble them.  You can make
use of the Flip and Rotate features in THERM to create multiple cross sections using the DXF files.  The
placement of these pieces can also be corrected within the drawing program that generates the DXF file.

If you have unexpected results when you export a DXF file, consider the following possibilities:

� Sometimes the DXF file comes into THERM with long vertical lines that do not show up on the original
drawing.  When this happens, it is best to reimport the DXF file into the drafting program, cut and paste
it into a new drawing, and export it again.

� Computer-generated drawings often contain entities on top of other entities.  This can occur when a
drawing is exploded on top of itself. When files like this are autoconverted, they arrive as overlapping
polygons in THERM.  Duplicate entities need to be removed before drawings are exported as DXF files.
AutoLISP routines are available that perform this task, but it is time consuming.  The overlapping entities
can be deleted easily in THERM.  If you delete one too many layers you can reinstate a layer using
THERM's Undo feature. The View/Show Voids/Overlaps feature is very useful for detecting overlapping
entities; however, multiple layers of overlaps may be difficult to detect because the first overlapping
region will be displayed as blue, the second one of top of it will be displayed as white, the third on as
blue, and so on.
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5.3.  Drawing Features
It is important to understand the following THERM features before starting your drawing.

5.3.1.  Sticky Distance

The sticky distance is 3mm (1/8") when a drawing is at 100% scale, which corresponds to about half of one
side of the cursor cross hair. As you zoom in or out, the sticky distance remains constant. This means that you
can zoom in to do finer detail because the sticky distance will get smaller relative to your drawing as you
zoom in and larger relative to your drawing as you zoom out.  Sticky distance only applies to mouse clicks,
not to numeric cursor positioning (see Section 5.5, “Drawing with the Keyboard” for a discussion of numeric
cursor positioning).

5.3.2.  Drawing Preferences

Use the Options/Preferences menu choice and go to the Drawing Options tab to change the following
drawing settings:

Figure 5-8.  Setting the drawing preference options

� Arc to polygon conversion:  This option tells THERM how to translate an arc in a dxf file into a polygon in a
THERM file. The smaller the value, the more line segments THERM will construct when translating the
arc. The default setting of 15o is recommended.

� Stay in Draw mode after drawing:  This option turns the Repeat Mode on by default.

� Always check for overlapping polygons:  This option tells THERM to check for overlapping regions each time
you edit or draw a polygon.  (Note: This checking procedure sometimes reports and overlap when there
isn't one. If you repeatedly get an error message saying you have overlapping polygons, you may want to
temporarily turn this feature off by unchecking the box.)  The program will check for overlaps at
simulation time; you can also check the drawing after it is finished using the View/Show Voids/Overlaps
menu choice.
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� Snap Preview:  This option affects how the cursor reacts to movement of the mouse. Snap Preview causes
the cursor to snap to any point that is within sticky distance. For complicated drawings this can be very
time consuming because the program must check every point to see if it is within sticky distance. This
option only affects what you see as you move the mouse, but does not affect snapping when you draw.

� Tape Measure Average Temperature:  This feature enables display of the average temperature over a straight
line segment measured by the tape measure. This feature is only available for a THERM file with current
and available results.

� Allow editing of IG polygons: This checkbox allows you control whether a glazing system imported from
WINDOW can be edited. If you activate this feature, you can then insert and delete points in a glazing
system. Use this feature with extreme care. The default value is unchecked, meaning the feature is not
activated.

� Prompt before deleting polygons:  This feature determines whether the program prompts you before deleting
polygons. The default setting is to ask for confirmation before deleting polygons. If this box is unchecked,
the program will not ask for confirmation before deleting a polygon. Under this circumstance, a polygon
that is inadvertently deleted can be restored using Edit/Undo.

� Drawing Size:  This option displays the overall size available for the THERM drawing. These dimensions
are modified automatically and will rarely need to be changed manually.

5.3.3.  Snap Settings

THERM has several “snap” settings that can be used to make drawing easier.  These settings instruct the
drawing cursor to automatically go, or snap, to certain points, lines, or angles.  How THERM decides where
to snap is determined in part by the sticky distance of the cursor.  If the cursor is snapping to points that you
don't want, use the zoom feature to zoom in and decrease the sticky distance.  (See Section 5.3.1 "Sticky
Distance" for more details).

Use the Snap Settings tab under the Options/THERM File Options menu choice to control the “Snap”
features in THERM.

Figure 5-9.  Setting the Snap Settings options, accessed from the Options/Therm File Options menu



5.  DRAWING CROSS-SECTION GEOMETRY

THERM 2.0 JUNE 1998 5-9

� Snap to Vertical:  If your drawing cursor is within the sticky distance of drawing a vertical line, the
program will snap the cursor to the exact vertical position.

� Snap to Horizontal:  If your drawing cursor is within the sticky distance of drawing a horizontal line, the
program will snap the cursor to the exact horizontal position.

� Snap to Underlay:  If your cursor is within the sticky distance of an underlay point as you trace a DXF
underlay, the program will snap the cursor to that point. If two points on the underlay are both within
the sticky distance to the cursor, the cursor may snap to the wrong point. Zooming in will decrease the
sticky distance and allow the cursor to snap to the desired point.

� Snap to Angle:  Much like Snap to Horizontal & Vertical, this feature allows the program to snap the
drawing cursor to a defined angle.

� Smart Snap:  This feature extends edges of polygons past the end points of polygons and checks to see if
the point that you want to insert is close to one of these lines.  This option is useful for lining up edges
when there is a gap between them. The View/Crosshair menu choice, which turns the drawing cursor
into a cross hair that fills the drawing area, can also be used for this purpose.

� Show Grid:  This option allows you to control whether the grid shows on the drawing area.

� Snap to Grid:  This feature forces the program to snap the drawing cursor to grid points.  If you use this
feature, you should also check the “Show Grid” option.

� Grid Spacing:  This option allows you to change the spacing of the drawing grid.  The default grid spacing
is 5 mm for both width and height. The minimum grid space is 0.3 mm; a smaller spacing is not visible on
most monitors.

� Grid Origin:  By default, the origin of the grid points falls on the drawing origin; by changing the x and y
values in the Grid Origin box, you can specify a different origin for the grid points.

When Grid Spacing and
Grid Origin are changed
(grid origin set to x=5 and
y=5, the grid changes but
the drawing origin stays in
it’s original location.

Figure 5-10.  Changing the grid origin relative to the drawing origin

Snapping occurs according to a defined priority sequence.  The list below shows the priority the program will
use to determine what to stick the cursor to.
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Snap Priority:

The snap priority is largely determined by what Snap Settings have been checked. The Snap Settings are
discussed in the previous section. Assuming that the Snap Settings are turned on, THERM will snap points
and polygons in the following priority order:

� Polygon point:  The highest priority is to stick to a point on another polygon.  This feature is always
enabled.  If the cursor is sticking to a point that you don’t want it to stick to, you need to zoom in (click
your right mouse button).

� Underlay point (for DXF only because bitmaps don’t have defined points):  The next level of priority is to
snap to underlay points.  This option can be turned on and off.  See the previous discussion of Snap
Settings, Snap to Underlay.

� Grid point:  The third level of priority is to snap to a grid point.  You can define the grid origin and
spacing, and the “snap to grid” feature can be turned on and off.  In the previous discussion of Snap
Settings, see Snap to Grid.

� Polygon line:  The fourth level of priority causes the cursor to stick to a line at the point perpendicular to
where the mouse clicks if the cursor is within the sticky distance of that line.  This feature cannot be
turned on and off.

� Smart Snap:  The fifth level of priority is enabled if Smart Snap is turned on.  In the previous discussion of
Snap Settings, see Smart Snap.

� Snap to Horizontal/Vertical:  The sixth priority is to snap so that an exactly horizontal or vertical line
segment is created.  In the previous discussion of Snap Settings, see Snap to Vertical and Snap to
Horizontal.

� Snap to Angle:  The last level of priority is to snap to a defined angle.  In the previous discussion of Snap
Settings, see Snap to Angle.

5.3.4.  Zoom

The zoom feature makes a drawing appear larger or smaller.  Click the Zoom toolbar button or use the
View/Zoom menu choice; a dialog box will appear with different percentage enlargements and reductions.

� This box will show the current zoom percentage. You can change this value to a specific percentage.

� The cursor becomes a magnifying glass. Place the magnifying glass over the center of the area to be
magnified and click the left mouse button.

You can also use the mouse to zoom as you are drawing:

� Zoom in (Right mouse click):  click the right mouse button to zoom in (make the drawing larger by a factor
of 2). The program will zoom in, using the cursor position as the center of the newly zoomed screen.

� Zoom out (Shift right mouse click):  hold the Shift key down and click the right mouse button to zoom out
(make the drawing smaller).

� Zoom to Fit (Ctrl right mouse click):  hold the Ctrl key down and click the right mouse button; the
program will zoom the drawing to the largest scale at which the entire drawing still fits in the view
window.

� Scrolling:  You can scroll your drawing both horizontally and vertically while zoomed in.

� Maximum Zoom:  You can zoom your drawing to 50,000%.
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NOTE:  The drawing features in THERM were developed using a 32-bit operating system, Microsoft Windows NT™.
THERM also runs on Windows 95™ and Windows 98™, which use 16-bit drawing functions. The zoom feature is one
of the few places where this difference is apparent. If you are using Windows 95™ or Windows 98™ and you experience
distortion of your drawing when zooming at a high level, make sure that the Windows 95 box is checked under
Options/Preferences. Even with this box checked, you may still see some display distortion of your drawing. If this
happens zoom out (Shift key + right mouse click) until the drawing appears accurate.

5.3.5.  Voids and Overlaps

In order for the automatic mesh generator to create a mesh there can be no voids or overlapping regions in
your drawing. There are many drawing features that help you to create a valid model as you draw, such as
snapping to points, filling voids, checking for overlapping and invalid polygons.

There is also a view option, View/Show Voids/Overlaps, that allows you to easily identify large voids and
overlaps. This feature draws the model in white and displays all overlaps and voids in blue (the area outside
the boundaries of the model will also be displayed in blue), and allows you to discover problems before you
define the boundary conditions. It is also a useful feature to fix similar problems after autoconverting a DXF
file; depending on how the DXF file was defined, overlapping polygons may be created during the
autoconvert process. See Section 5.2.3, "DXF File Conversion" for more details. Figure 5-11 shows an example
of this view option.

Voids and overlaps that are smaller than a pixel at the zoom level of the model when the View/Show
Voids/Overlaps feature is selected may not show up even after subsequent zooms. THERM has a feature that
can detect small voids and overlaps that is activated later in the modeling process. See Chapter 7 for more
details.

With View/Show Voids/Overlaps
turned on, THERM displays any
voids or overlapping regions as
one color and all the defined
regions as white.

Figure 5-11.  Use the Draw/Show Voids/Overlaps menu to view voids.
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5.3.6.  Other Drawing Features

Other drawing features that may help you create the cross-section geometry are:

� Draw Repeat Mode:  This feature, accessed from the Draw/Repeat Mode menu choice or the Draw Repeat
Mode toolbar icon, keeps you in the drawing mode you are currently in.  For example, if you are drawing
polygons with the Repeat Mode feature on, your cursor stays in "draw polygon" mode, so you don’t have
to continually reselect the Draw/Polygon menu choice or toolbar button.

� Material Colors:  The View/Material Colors menu choice allows you to turn the polygon colors on and off.

� Set Draw Color:  The View/Set Draw Color menu choice allows you to select a color for the drawing line
when drawing polygons. This feature helps you keep track of where you are when drawing a
complicated polygon. The default color is black.

� Set Polygon Border Color:  The View/Set Polygon Border Color menu choice allows you to select a color
for the borders of the polygons. The default color is black.

� View Polygon Vertices:  The View/Polygon Vertices menu choice displays the vertices of all the polygons
in the model. This feature can be very useful when drawing polygons that share a common complicated
edge.

� Select Materials:  You can select materials as you draw each polygon; when you are in "draw polygon" or
"draw rectangle" mode, pick the material for the component you are about to draw from the material list
in the right-hand section of the toolbar.  This material will then be assigned to the polygon.  You can also
assign materials after the polygons have been drawn.

� Set Drawing Scale:  This feature allows you to convert drawings to full scale (1" = 1"). Changing the
drawing scale changes all of the dimensions in the drawing. It should not be used to resize individual parts.
THERM will allow imported glazing systems to be rescaled, but this is not recommended because the
properties of the glazing system are dependent on the dimensions of the geometry as defined in
WINDOW. In this version of THERM, these properties are not corrected when the glazing system is
rescaled.

1. Select the Draw/Set Drawing Scale menu choice.

Figure 5-12.  Select Set Drawing Scale from the Draw menu.
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2. A small tape measure will appear.  Put the tip of the arrow on the tape measure at the point from which
you want to start measuring and press the left mouse button.  Then move the tape measure arrow tip to
the point where you want to finish measuring, and press the left mouse button (the cursor will snap to
points within the sticky distance). Type in the actual line length value.

Figure 5-13.  After measuring the distance, type in the dimension to which you want that distance to be set.

5.4.  Drawing Using a Mouse
This drawing discussion assumes use of a mouse; this is the technique most likely to be used when tracing an
underlay.  See the discussion following (“Drawing Using a Keyboard”) for methods to use the keyboard for
drawing, which may be faster and more accurate than using a mouse if you have a dimensioned drawing.

For this example, we are tracing an underlay and will draw many polygons to represent the model.  The
figure below shows numbered steps for creating a polygon.

Steps 3-7:
Place the drawing
cursor where you want
to start the first
polygon, click the left
mouse button and
drag the mouse,
following the lines in
the underlay. Click the
mouse to end the line.

Repeat this until the
polygon is closed.

Step 1:
Push the Draw
Polygon button.

Step 2:
Select Material

Figure 5-14.  Steps for drawing cross-section geometry

1. To draw the first polygon, press the Draw Polygon toolbar button or use the Draw/Polygon menu
item.

2. Pick the material for the polygon from the material list in the right-hand section of the toolbar.

3. Place the drawing cursor where you want to start the first polygon.

4. Click the left mouse button to set the starting point for the first line. (THERM will snap to the nearest
vertex if you are using a DXF file).
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5. Move the mouse to the right and a line will follow the mouse.  Click the left mouse button when you
get to the end point for the line, and THERM will draw the line. A point is automatically created at
each end of this new line.

6. Continue drawing the edges of the polygon in the same manner, moving the cursor to the next line
end point, and clicking the left mouse button to define that point.

7. When you only have one line left to draw, you can double-click the left mouse button, click on the
first point, or press C to close the polygon.

Figure 5-15.  Drawing a polygon by tracing an underlay element

If you find that the program is “snapping” lines to points that you don’t want, try zooming in.  If you
are still having problems, you may need to turn off some of the options in Options/THERM File
Options menu, under the Snap Settings tab.

After you have drawn the first polygon, use the same procedure to draw all the other polygons
required to provide an accurate representation of the cross-section.  For THERM to perform its
calculation, a cross section made out of multiple polygons must not contain any voids or overlaps.
(See Sections 5.3.5, "Voids and Overlaps", and 6.3, "Error Detection in THERM" for more
information). The "snap" feature (see Section 5.3.3, "Snap Settings") as well as THERM's dynamic
checking as you draw are intended to minimize unintentional creation of voids and overlaps.
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Figure 5-16.  The first polygon is complete; start the next polygon.

5.4.1.  Suggestions for Drawing Cross Sections

You will be able to successfully draw complicated cross-sections in THERM if the following guidelines are
adhered to.  These guidelines apply to the drawing of extrusions and how to best represent arcs and curves.

� Extrusions: Currently THERM does not draw multiply connected regions or "donuts".  This limitation is
most noticeable when drawing components created from extrusions (or pulltrusions).  Here are some
suggestions to aid in the creation of THERM models for extruded products.

� The standard method for drawing an extrusion in a CAD program is to draw the outside edge of the
extrusion and then draw the cavities.  Creating a model in THERM uses a different logic.  First draw
the extrusion and then fill the cavities using the automatic fill void feature.

� THERM can handle very complicated polygons but it is easier to keep track of what you are doing if
you use many less complicated polygons.  It is easy to forget where you started drawing the polygon
if it is too complicated.

� Complicated intersections between two pieces of the same material in intimate thermal contact can be
simplified without effecting the thermal performance of the cross section.

� When breaking up extrusions you should avoid introducing detail into the cross section to do this:

� Make the breaks at vertices that already exist in the drawing.

� Avoid creating acute angles.

� Avoid creating very small rectangles.

The next two figures give an example of how the above drawing principles can be applied to an extruded
product.
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Do not draw acute angles
when it is not necessary.

Do not create small
polygons in the process of
breaking up the extrusion.

Simplfy the geometry
between polygons with
the same material.

Figure 5-17.  This cross section illustrates drawing mistakes when breaking up an extrusion.

Angles are not acute.

The boundary between
these two polygons of
the same material has
been simplified.

The segments
used to prevent
drawing a donut
are composed
of large
rectangles.

Breaks are made
at existing points.

Figure 5-18.  This cross section illustrates a better way to draw the extrusion geometry in Figure 5-17.

� Arcs and curves:  The default value converts arcs into line segments every 15 degrees. This level of detail
is appropriate for curves with a radius greater than 3mm.  If the curve has a radius greater than 1 mm
and less than 3 mm then breaking up the arc every 30 degrees (or combining two segments on the DXF
file underlay) is adequate.  If the radius of the curve is less than 1mm then every 45 degrees (or
combining three segments on the DXF file underlay) is sufficient.  These guidelines are based on an
attempt to keep the difference between the approximated curve and the real curve small, approximately
0.1 mm.  This distance can be checked using the tape measure.  Using many points to model curves in
THERM may create problems for the mesher.  The guidelines listed above should result in a good
representation of the geometry for the purposes of thermal analysis.
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5.5.  Drawing Using the Keyboard (Numeric Cursor Positioning)

If you are working from a dimensioned drawing, it may be easier and more accurate to use the keyboard and
THERM’s numeric cursor positioning rather than using the mouse.  Numeric cursor positioning allows you to
move the cursor to either an absolute or relative location by typing a number and pressing an arrow key.

Follow the steps below to draw polygons with the keyboard:

1. Type Alt-D:  Shows the Draw menu.

2. Type P or R:  With the Draw menu showing, type P for Polygon or R for Rectangle.  The cursor will
appear on the drawing area. (These functions can also be accessed with the mouse by clicking the
appropriate toolbar button).

3. Move the cursor to the starting point of the drawing:  There are several different methods for moving the
cursor to where you want to start:

� If you want to start drawing at the origin, press the Home key.

� If your starting point is not at the origin, type the x coordinate; the Step Size dialog box will
appear. Select Absolute (Relative is the default), and press the right arrow key; then type the
y coordinate followed by the Up Arrow key, and the cursor will be positioned at those
coordinates.

4. Press Enter:  Press the Enter key to start drawing (the equivalent of clicking the mouse button).

5. Type the first dimension (a number):  Type the first line length for the polygon you are going to draw.
The Step Size dialog box appears, and the step size value is set to the dimension you typed.  Do not press
Enter and do not click on the OK button with the mouse. (The OK button is used when you are setting
the step size for future use.)

Figure 5-19.  Type a  number to bring up the Step Size dialog box.

6. Press the Up, Down, Left, or Right Arrow:  Press the appropriate arrow key (i.e., the right arrow to draw
a line to the right); a line of the specified step size will be drawn in the direction of the arrow.

7. Press Enter to commit the line:  Press Enter to commit the line to the drawing.  The new line will appear;
a vertex has been established where the cursor is positioned.

8. Type the next dimension (a number).

9. Press the appropriate arrow key.

10. Press Enter to commit the line.

11. Continue drawing lines until you have only one line remaining to complete the polygon.

12. Press C to Close:  Press C to draw the last segment of the polygon.  The program will automatically draw
a line from the point where the cursor is resting to the first point drawn for the polygon.
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Other conventions to know when using the keyboard to draw:

� Enter starts drawing:  Pressing the Enter key to start drawing a polygon will cause the cursor to snap
(according to the snap settings).  This makes it easy to start drawing from a point that you have already
defined.

� Mouse-driven commands: Mouse-driven commands work even when using the keyboard; there are several
short-cut keys designed for keyboard drawing. (See Sections 3.9 and 3.10 for more details about short
cuts).

� Absolute Locations:  Absolute locations can be entered by using the Absolute setting in the Step Size
dialog box. For example, to move the cursor to x=10 and y=5, click on the Absolute button, type 10, press
the up arrow, type 5, and press the right arrow.

Figure 5-20.  Type the step value to bring up the Step Size dialog box, and click on the Absolute button.

� Ctrl + arrow key:  If you press the Ctrl key while moving the arrow keys, the cursor will move 10% of the
specified step size.  For example, if the step size is set to 1 mm, pressing the Ctrl+Right Arrow keys will
move the cursor 0.1 mm to the right. This feature can be very useful when extreme accuracy is needed to
place a point or line.

� Space bar:  Press the Space bar if you want to snap to the point or polygon that is within the sticky
distance of the cursor.

� End:  While you are drawing a polygon, you can press the End button to get back to the most recent
previous point you drew.

� Esc:  If you draw a point by mistake, press the Esc button and it will be deleted. If you press Esc again, a
dialog box will give you the choice of deleting the point previous to the last point you just deleted (this
can be done several times, but the video display tends to get garbled), deleting the polygon, or canceling
the Escape command.

5.6.  Editing Polygons
Once a polygon has been drawn, it can be edited.  For example, the entire polygon can be moved; points can
be added, deleted or moved; etc. Because a rectangle is one type of polygon, any reference in this manual to
polygons also applies to rectangles.

5.6.1.  Selecting a Polygon

Several different techniques can be used to select a polygon:

� Left Mouse Click:  Put your mouse cursor over the polygon you want to select and click the left mouse
button. You can tell that a polygon has been selected because all the points on it will be displayed as
squares.
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� Ctrl or Shift left mouse click:  If you want to select multiple polygons, you can hold either the Ctrl or Shift
keys down as you click your mouse on the polygons to be selected.

� Tab:  You can use the Tab key to select any polygon in the drawing; each time you press Tab, the
program will select the next polygon. By pressing Tab multiple times, you can "tab around" to all the
polygons in your drawing. This is sometimes a good way to select very small polygons that you can’t
easily select using the mouse.

� Selection box:  You can draw a "selection box" around a polygon or a group of polygons by clicking and
holding down the left mouse button in the drawing area and dragging the mouse in a diagonal motion so
that a dashed box is drawn around the polygon(s) that you want to select. Release the mouse button, and
the polygons surrounded by the dashed box will be selected.

Step 1: Position the mouse cursor where you
want to start the "selection" box.

Step 3: Release the mouse
button, and all polygons
completely surrounded by the
selection box will be selected.

Step 2: Hold the
left mouse
button down and
drag the mouse
cursor from
1 to 2.

1

2

Figure 5-21.  Selecting polygons using the selection box

� Select Special:  You can use the Edit/Select Special menu choice to select polygons or boundary conditions
of a certain type or ID. This menu choice brings up a dialog box that allows you to specify the type of
object you want to select. This is an efficient way to change the materials of many identical objects with
one command.

When you do a calculation, you will occasionally get an error message saying that there is a bad polygon
in the model. This message returns a polygon ID number. Using Select Special allows you to quickly
locate that polygon in the model. See Chapter 7 for information about fixing invalid polygons.
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Step 2: Go to
the
Edit/Select
Special menu
choice.

Step 4: All polygons
of the type specified
will be selected.

Step 1: Select a polygon
(or boundary condition) of
the type you wish to use
so you can select all the
elements in the drawing
of this type.

Step 3: The Select
Special dialog box opens.
Make sure all the input
values are as you want
them; then, click on OK.

Figure 5-22.  Using Select Special for selecting polygons

5.6.2.  Moving a Polygon

To move a polygon:

1. Click the mouse on the Move toolbar button, or use the Draw/Move menu choice.

2. Place the mouse cursor inside the polygon that you want to move. Click and hold down the left
mouse button as you move the mouse to the new location; release the mouse button. The polygon
will move to the new location.  Any snap settings in effect during the move will apply to the moved
polygon.

When moving a polygon, you can hold the Shift key and the left mouse button down together as you drag
the mouse and move the object; in this situation, THERM constrains the movement to the horizontal and
vertical directions.

It is recommended that you use the drawing locator feature when moving multiple polygons.

1. Place the locator (select the Draw/Locator menu choice or press Shift F2, and click the left mouse
button) on a point on one of the polygons to be moved; this point will be used to place the polygon in
its new location.

2. Select all of the polygons to be moved, using any of the methods discussed in Section 5.6.1.

3. Cut (Ctrl-X) the selected polygons.

4. Place the locator (use Shift F2 and click the left mouse button) at the location to which you want the
point selected on the polygon in Step 1 to move. (The locator can be moved with the keyboard Step
Size functions. It will stick to existing points within the sticky distance.)

5. Paste (Ctrl-V) the selected polygons. If no overlaps are created, the polygons will be pasted in the
new location.
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Step 1: Click on the Move Polygon
toolbar button.

Step 2: Position the mouse cursor over the
polygon to be moved. Click and hold down the
left mouse button, drag the mouse (and the
polygon) to the new location, and release the
mouse button. The polygon will be moved to
the new location.

Figure 5-23.  Moving a polygon

5.6.3.  Deleting a Polygon

To delete a polygon:

1. Select the polygon (click the left mouse button while the cursor is inside the polygon) that you want
to delete.

2. Press the Delete key on your keyboard.

3. A message will appear asking if you want to delete the selected polygon.  If you do, press Enter to
accept the default “Yes” response. (Note: You can disable this question in the Drawing Options tab
accessed from the Options/Preferences menu, by unchecking the "Prompt before deleting polygons"
checkbox.)

4. The polygon will disappear. (If you delete a polygon by mistake, use the Edit/Undo menu choice or
Ctrl-Z to have the program reinstate the polygon).

5.6.4.  Moving a Point

To move a point on a polygon:

1. Click the mouse on the Edit Points toolbar button or use the Draw/Edit Points menu choice.

2. Select the polygon (click the left mouse button while the cursor is positioned inside the polygon) so
that the vertices are displayed.

3. Move the cursor to the point to be moved.

4. A double-arrow cursor is displayed when you are within sticky distance of the point.

5. Use the Step Size and Arrow keys to move the point, or click and drag the point with the left mouse
button.
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6. The lines attached to the point are pulled along with it.

When moving a point, you can hold the Shift key and the left mouse down together as you drag the mouse to
move the point; in this situation, the program constrains movement to the horizontal and vertical directions.

Step 1: Click on the Edit Points
toolbar button.

Step 2: Move the mouse cursor over
the point you want to move; the
cursor will change to a double
arrow.

Step 3: Click the left mouse
button, hold the button
down, drag the cursor to the
new location for the point,
and release the mouse
button when the point is in
the desired location. The
point will be moved, and the
polygon lines attached to
the point will stretch to
follow.

Figure 5-24.  Moving a point on a polygon

5.6.5.  Moving a Line

To move a line on a polygon:

1. Select the polygon (by clicking the left mouse button) so that the points are displayed.

2. Press the Edit Point toolbar button, or use the Draw/Edit Point menu choice.

3. Move the mouse cursor over the line you want to move; a four-point arrow cursor appears when you
are in a position that allows you to move a line. (Note that you need to be outside the sticky distance
of any nearby points in order to see the four-point arrow; use the zoom in feature by clicking the right
mouse button if you are sticking to points).

4. When the four-point arrow cursor appears, hold down the left mouse button and drag the line to the
new location, or use the arrow keys to move the line a specified distance. When the line is in place,
release the mouse button, which will cause the line to move and the polygon to be resized.

When you are moving a line, you can hold the Shift key and the left mouse down together as you drag the
mouse to move the points; and the program will constrain the movement to the horizontal and vertical
directions.
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Step 1: Click on the
polygon that has the
line you want to move.

Step 2: Click on the
Edit Points toolbar
button.

Step 3: Position your
mouse cursor over the
line you want to move,
and you should see a
cross hair with arrows.

Hold the left mouse
button down, drag the
cursor to the new line
location, and release the
mouse button. The line
and all the lines and
points attached to it will
move to the new location.

Figure 5-25.  Move a line by pressing the Edit Point button and placing the "move line" cursor over the line to be moved; hold the
left mouse button, and move the mouse in the desired direction.

5.6.6.  Adding a Point

To add a point on a polygon:

1. Move the mouse cursor over the polygon that is to contain the new point, and press the left mouse
button. This selects the polygon so that the points of the polygon are displayed.

2. Press the Insert Point toolbar button, or use the Draw/Insert Point menu choice (Shift-F6).

3. Move the mouse cursor to the point on the polygon edge where you want to add the new point.
When the mouse cursor is properly positioned, click the left mouse button, and the new point will be
displayed. It is also possible to use the keyboard input method (see Section 5.5) to move the cursor to
the location where you want the point to be inserted, and then use the Draw/Insert Point menu
choice. The Insert Point command does not recognize the snap priorities. If you are using the
keyboard input method to insert a point at a set distance from an existing point, move the cursor near
that point, and press the spacebar so the cursor snaps to that point. This will ensure that the point is
inserted the exact distance specified by the keyboard input method.

A common cause of the message saying the program cannot create overlapping regions is when you try to
insert a point within the sticky distance of an existing point. In this situation, zoom in to the drawing by
clicking the right mouse button.
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Step 3: Move the cursor (a
single arrow) to the point on
the line where you want the
new point. Click the left
mouse button, and THERM
will add the point.

Step 1: Click (left mouse
button) on the polygon
that will contain the new
point.

Step 2: Click (left
mouse button) on the
Insert Point toolbar
button.

Figure 5-26.  Add a point by pressing the Insert Point button and clicking where the point is to be inserted.

5.6.7.  Deleting a Point

To delete a point on a polygon:

1. Click the mouse on the Edit Points toolbar button, or use the Draw/Edit Points menu choice.

2. Select the polygon (click the left mouse button) so that the points are displayed.

3. Move the cursor to the point to be deleted (get within sticky distance of the point).

4. A double-arrow cursor is displayed.

5. Press the Delete key on your keyboard, and the point will be removed. If you delete a point by
mistake, use the Edit/Undo menu or Ctrl-Z to undelete it.

5.7.  Flip and Rotate
THERM has two drawing features that allow you to manipulate the entire cross section, Flip and Rotate. You
can use these functions to create sloped cross sections, as well as to use the same components multiple times
in different orientations. Keep in mind that:

� Complicated drawings may take a few seconds to flip.

� If the drawing isn’t visible in the drawing area, use Ctrl-Right mouse button to center it.
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5.7.1.  Flip

From the Draw menu, select the Flip choice, and then either the Horizontal or Vertical options. Figure 5-28
shows the result of horizontally flipping the cross section in Figure 5-27.

Figure 5-27.  Select Flip from the Draw menu.

Figure 5-28.  The cross section has been flipped in the horizontal direction.
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5.7.2.  Rotate

From the Draw menu, select the Rotate choice, and then either the Left 90o, Right 90o, 180o or Degree options.
Choosing Degree displays a dialog box which allows you to enter the exact degrees of rotation. Figure 5-30
shows the result of horizontally flipping the cross section in Figure 5-29.

Figure 5-29.  Select Rotate from the Draw menu.

Figure 5-30.  The cross section has been rotated 180 degrees.
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5.8.  Fill Void

THERM has a drawing feature that allows you to create a polygon by "filling" a void or undefined area in the
cross section that is completely surrounded by other polygons. When this polygon is created, THERM
automatically creates all the necessary points to match the points on the surrounding polygons. This feature
eliminates the need for you to draw these potentially complicated polygons.

Figure 5-31 contains a cross section which has an undefined area completely surrounded by polygons, which
is a perfect candidate for using the fill void feature. To create a polygon for this cavity, follow these steps:

� Click the left mouse button on the Fill Void toolbar button.

� The drawing cursor will change to the Fill Void cursor.

� Place the Fill Void cursor inside the undefined are that you want to fill with a polygon.

� Click the left mouse button, and THERM will draw a polygon that fills the area and contains points
matching all the vertices on the adjacent polygons, as shown in Figure 5-32.

� You may need to select the newly created polygon and change the material. See Section 5.10, "Assigning
Materials After Drawing Polygons".

A polygon for this undefined
cavity area can be created
using the Fill feature.

Step 1: Click on the Fill Void
toolbar button.

Step 3: Place the drawing Fill Void cursor
inside the area you want to "fill" and click the
left mouse button.

Step 2: The drawing cursor
changes to the Fill Void cursor.

Figure 5-31.  Click on the Fill Void toolbar button, place the drawing cursor inside the void to be filled, and click on the left mouse
button.
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THERM creates a polygon
in the cavity that includes
points matching all
vertices on the adjacent
polygons.

Figure 5-32.  The Fill Void feature creates a polygon in the cavity containing points matching all vertices on the adjacent polygons.
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5.9.  Inserting a Glazing System

When you have drawn the nonglazed elements of your cross section, you are ready to add a glazing system.
If you used Autoconvert for a DXF file, you should delete any polygons that may have been automatically
drawn by THERM for the glazing system.  Although it is possible to draw the glazing system from individual
components and assign materials to them, it is much easier to insert a glazing system from the WINDOW
library.  Material properties and boundary conditions are predefined if you use this feature. A sample glazing
system library (glzsys.w4) is included with THERM. Additional glazing systems can be created using the
WINDOW program.

5.9.1.  Inserting a WINDOW4 Glazing System

THERM can read the Glazing Systems Library created by WINDOW4 and automatically insert glazing
systems into your cross section drawing if you do the following:

1. Specify the location for the glazing system to be inserted by selecting the Draw/Locator menu choice.

Figure 5-33.  Select Locator from the Draw menu.

2. Click with the left mouse button on the location for the lower left-hand corner of the inserted glazing
system; a small circle will appear at the selected location.
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Position Locator:
Place the drawing cursor in the lower left
corner of the area where the glazing
system will be inserted, and click the left
mouse button. A small circle will appear,
which is the Locator. The program will
automatically place the lower left corner of
the glazing system where the Lcoator is.

Figure 5-34.  A small circle indicates the location of the lower left corner of the glazing system to be inserted.

3. Select the Libraries/Glazing Systems menu choice.

Figure 5-35.  Select the Glazing Systems choice from the Libraries menu.

4. From the Glazing Systems dialog box, shown below, specify the path by which the program can find the
Glazing System Library file, GLZSYS.W4.  Use the Browse button to find GLZSYS.W4 files; all Glazing
Systems defined in the specified GLZYSYS.W4 library will appear in the Glazing System pull-down list.

Figure 5-36.  Select a WINDOW4 glazing system from the Glazing Systems dialog box.

5. Pick the desired Glazing System from the pull-down list.  If you want THERM to use the Condensation
Index (CI) Model when simulating the cross section, check the Use CI Model for Window 4 Glazing
Systems check box. If you do not check this box when you import the glazing system and later decide to
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do a CI calculation, you may select this model under Options/Therm File Options. If you select this
option, you will get U-factors based on the CI algorithms which are slightly different from the algorithms
in WINDOW4.1; these U-factors are not consistent with current NFRC U-factor procedures.

6. Press the Import button.

7. Another dialog box will appear, asking for the position of the glazing as well as dimension information.

While the Insert Glazing System dialog box is open, it is possible to use the Tape Measure toolbar
button to go to the drawing, determine the dimensions needed, highlight the dimension and press
Ctrl-C to copy the value from the Tape Measure results box, and then press Ctrl-V to paste the value
into the Insert Glazing System input boxes.

Figure 5-37.  Specify the location and dimensions for the inserted glazing system.

Orientation Orientation of the glazing system. Up means the spacer will be at the bottom of the
drawing.  Down turns the glazing system upside down, placing the spacer at the top of
the drawing.  This orientation can be changed using the flip and rotate features once the
glazing system has been imported. Default:  Up.

Actual cavity
height The total height of the glazing system cavity.  Default:  39.37 inches (IP); 1,000 mm (SI).

This value is only important when doing a CI calculation.
Site line to
bottom of glass Distance from the frame sight line to the bottom of the glass, which forms the

demarcation point between the frame and the edge. For NFRC window modeling
purposes, the sight line is the demarcation point between the frame and the edge U-
factor calculations. Default:  0.5 inches (IP);  12.7 mm (SI).

Spacer height Distance from the top of the spacer to the bottom of the glazing system. This dimension
determines how THERM will draw the generic spacer or how much space to leave if the
Draw spacer box is not checked. Default:  0.5 inches (IP); 12.7 mm (SI).

Edge of Glass
Dimension Dimension of glazing that is used to calculate the impact of the frame "edge effects."

Default:  2.5 inches (IP); 63.5 mm (SI).
Draw spacer If this box is checked, the program will draw a rectangle of the chosen material when the

glazing system is imported. If it is unchecked, the program will leave the spacer area
blank, and you can draw your own spacer or paste in a spacer from another THERM file
(see Section 5.12, "Creating a Component Library" later in this section). Default:
unchecked.

Spacer material If the Draw spacer box is checked, this pull-down choice will determine the material of
the rectangle that the program draws to represent the spacer.
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The drawing below illustrates the dimensions being defined in the Insert Glazing System dialog box.  These
dimensions are used by the program to determine how much area to leave for the spacer, and to determine
the demarcation point between the frame and the edge.

Generic spacer drawn
by THERM if "Draw
spacer" is checked.

OUTSIDE INSIDE

Line of Sight
Sight line to
bottom of glass

2.5"

Spacer height

Edge of glass
dimension

Figure 5-38.  Illustration of dimension definitions used in the Insert Glazing System dialog box

8. THERM will insert the glazing system, as shown below, including the appropriate number of glazings
and cavities.  If the Draw spacer box was unchecked, an opening is left for a spacer, which must be
defined separately.  You can draw rectangles to represent the spacer or paste a spacer from another
THERM file into this drawing (see Section 5.12, "Creating a Component Library" for more details.)
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Figure 5-39.  THERM inserts the glazing system in the drawing based on the position of the Glazing Locator.

9. You may need to move the glazing system after it is inserted (see Section 5.6, "Editing Polygons").  The
glazing layers and cavities are grouped together and can be moved as a unit.  Although it is possible to
separate these layers (if you turn on the Allow editing of IG polygons from the Options/Preferences
menu choice, on the Drawing Options tab), it is recommended that you do not do this. Instead, to change
the glazing system, you should delete the existing glazing system (using the same technique as for
deleting any other polygon except that all glazing system polygons will be deleted as a group) and
import a new glazing system from WINDOW4.  Although it is possible to create a glazing system in
THERM by drawing polygons and assigning materials, this is only recommended when you are
modeling a nonstandard product because the process is time-consuming and difficult to do correctly.

10. If you checked the Use CI Model for Window 4 Glazing Systems box when importing the glazing
system, you will see red boundary conditions in the cavity between the layers of glass (for multipane
systems). These are drawn automatically by the program.
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THERM draws boundary conditions for the glazing
cavity. Click once on the boundary segment to
see the definition; click twice to display the dialog
box with features of the Glazing Cavity Surface.

Figure 5-40.  Condensation Index procedure for glazing cavities

The Glazing Cavity Surface dialog box appears when you double-click on a glazing cavity boundary
condition created using the Condensation Index feature of THERM. The fields are the following:

Emissivity The emissivity of the surface.
Side The side of the surface relative to the cavity. The choices are:

� Adiabatic

� Left

� Right

� Open

Temperature The temperature of the surface.

Blocking Surface This check box is used to indicate whether the surface is blocking radiation transfer. The
default value in the program is that all surfaces are blocking. Unless you are worried
about calculation speed (under default conditions, calculation time may be longer), it is
easiest and most accurate to keep the default on.

5.9.2.  Condensation Index

The Condensation Index (CI) Model provides an alternative method for determining heat transfer through
glazing systems.  It was developed to improve the accuracy of local temperature modeling which is important
in predicting where condensation will occur in a fenestration product.  Glazing systems imported from
WINDOW4 use an effective conductivity model to account for conduction, convection, and radiation.  The
convection model is based on a single value determined from the average behavior of the entire glazing
cavity. The traditional radiation model assumes infinite parallel plates of constant temperature within the
component being modeled(2).  These assumptions have been shown to yield acceptable results for the average
heat loss (U-factor), but they are inadequate for predicting local temperatures(13).  The condensation index
model included in THERM(14,15) uses local film coefficients and a detailed radiation model. This more detailed
model has been shown to give more accurate local temperature results then the effective conductivity model.
The condensation index model calculates U-factors based on the CI algorithms which are slightly different
from those in WINDOW 4.1; these U-factors are not consistent with current NFRC U-factor procedures.  It is
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currently limited to modeling glazing cavities with pure gas (air, argon, or krypton).  This restriction will be
eliminated in future versions of the program.

� Turn on the Condensation Index Model. The Condensation Index Model can be activated in two
different ways:

� Turn it on for all imported glazing systems: By checking the Use CI Model for Window 4 Glazing
Systems checkbox in the Therm File Options choice of the Options menu, as shown in Figure 5-41,
you set this option for all glazing systems that are imported into THERM.

� Turn it on for each glazing system as you import it: By checking the Use CI Model for Window 4
Glazing Systems checkbox on the Glazing System Library dialog box when you import a system
from WINDOW, as shown in Figure 5-42, you can specify for individual systems whether to use the
CI Model.

If the Condensation Index Model is not checked when the glazing is first imported, it can be changed
before the final calculation in the Therm File Options dialog box; checking the CI Model checkbox at that
time will change the model of a glazing system already imported into THERM.  This way, you can do a
calculation for U-factor and then do a condensation index calculation without redrawing the model.

Click on this check box
(either before or after you
import a glazing system
from WINDOW) to use the
Condensation Index Model
for glazing cavities

Figure 5-41.  Check box for turning on the Condensation Index feature for glazing cavities
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Click on this check box when
you import a glazing system
from WINDOW to use the
Condensation Index Model for
glazing cavities

Figure 5-42.  Check box for turning on the Condensation Index from the Glazing System Library
when importing a system from WINDOW.

� Import a glazing system from WINDOW4. The glazing system appears with the glazing cavity
surrounded by a red line.  This is an easy way to tell whether an effective conductivity or condensation
index model is being used.  The condensation index model does not treat the glazing cavity as a solid
material but as an additional boundary condition.  This boundary condition is automatically defined
when the glazing system is imported.  Double-click on this boundary to make sure it is correct for your
model.

Glazing Cavity Surface boundary conditions are
atuomatically generated for an imported
WINDOW glazing system if the Condensation
Index model is activated (either when imported,
or using the Options/Therm File Options menu.

Double-click on one of the Glazing Cavity Surface boundary
conditions to see the properties of that boundary condition.

Figure 5-43.  Condensation Index procedure for glazing cavities

The Glazing Cavity Surface dialog box appears when you double-click on a glazing cavity boundary
condition created using the Condensation Index feature of THERM. The fields are the following:

Emissivity The emissivity of the surface. This value comes from the WINDOW glass library which
must be in the same subdirectory as the glazing system library; otherwise, a default
value of 0.84 is used.  This value can be overridden.

Side The side of the surface relative to the cavity. The choices are:

� Adiabatic:  assigned to the bottom of the glazing system.
� Left:  assigned to the left surface of the glazing cavity.

� Right:  assigned to the right surface of the glazing cavity.
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� Open:  assigned to the top of the glazing cavity.  When this condition is chosen,
THERM sets the temperature equal to the average glazing cavity temperature.

Temperature The temperature of the surface. These values are obtained from the WINDOW glazing
system library.  The temperature of the Open boundary is the average glazing cavity
temperature.  There is no temperature shown for the Adiabatic surface because it is not
used in the calculation.

Blocking Surface This check box is used to indicate whether the surface is blocking radiation transfer. The
default value in the program is that all surfaces are blocking.  See Section 6.4.1, "Frame
Cavities with Detailed Radiation Model" for a definition of blocking surfaces.  For a
typical glazing cavity with parallel glazing layers, the spacer is the only component that
could provide a blocking surface.  Changing the default on a surface that is actually
nonblocking may provide a modest increase in calculation speed.  Labeling a blocking
surface as nonblocking will result in incorrect results.  It is recommended that you use
the program default value, which causes the program to determine whether or not the
surface is blocking.

5.9.3.  If the WINDOW4 Glazing System Doesn’t Fit

When you try to insert the W4 glazing system, you may get the following message:

Figure 5-44.  Message displayed if the Glazing System cannot be inserted

Either reposition the Locator, or move elements of the cross section to allow the glazing system to fit.  In
addition, you can obtain the width of the glazing from WINDOW4 and edit the cross section to fit.  Glazing
systems are usually separated from the frame on both sides by tape or sealant.  The best way to insert a
glazing system is to draw a polygon representing the sealant on one side.  This polygon helps to locate the
glazing system.  Once the glazing system is imported, draw a polygon to represent the sealant on the other
side of the glazing system.  These sealant polygons are small, so you will probably need to zoom in to draw
them.

Another possible reason that the glazing system doesn’t fit is due to a round off discrepancies. The thickness
of the glazing system in WINDOW 4.1 is calculated to three decimal places in either SI or IP units. However,
the tape measure gives lengths to four decimal places in IP units and three decimal places in SI units. If you
are having trouble fitting the glazing system, you may want to try measuring the space for the glazing system
with the tape measure in SI units to eliminate the possible round-off error.

5.9.4.  Inserting Multiple WINDOW4 Glazing Systems

You can place more than one glazing system in a drawing.  When you add systems, the program asks if you
want to replace the existing system or add another.

5.9.5.  Information about the Glazing System

You can view information about the inserted glazing system by double-clicking your mouse on any part of
the glazing system. The following window will appear:
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Figure 5-45.  Double-click on the inserted glazing system to see information about the system.

5.10.  Assigning Materials After Drawing Polygons

Material properties must be specified for each polygon. While you are drawing, THERM assigns the most
recently used material.  You can select the material as you are drawing or change the material assignments
after the polygons have been drawn.

There are two different classes of materials, solids, and cavities.  Solids have a specified thermal conductivity.
A frame cavity model is used to calculate the effective conductivity for cavities commonly found in
aluminum, vinyl, and fiberglass window frames.  The glazing cavity in an insulated glazing unit is treated as
a solid with an effective conductivity that accounts for conduction, convection, and radiation (see Section
5.9.2, "Condensation Index" for an alternative way of treating the gas cavity).  It is recommended that the
glazing cavity be modeled by importing a glazing system from WINDOW4.

After the polygons are drawn, you can assign a different material to them by using one of the methods
discussed below. You can select multiple polygons that all need to be assigned the same materials using the
selection techniques discussed in Section 5.6.1, "Selecting a Polygon."

5.10.1.  Use the Material pull-down list to the right of the toolbar:

1. Select the polygon by placing your mouse inside the object and clicking the left mouse button.

2. The vertices of the selected polygon are indicated as squares.

3. Select the appropriate material from the list in the upper right corner of the toolbar.  The choices in
the list show all the entries in the Material Library[16].  A fast way to move through the list is to type
the name or even just the first few letters of the material you want. For example, typing Wood would
put you on the first instance of Wood in the Material List, Wood (Cedar or Redwood). You could
then use the down arrow key to get to Wood (Pine, Spruce, Fir).  You can then press Enter or click on
the material with your left mouse button, and the selected material will be assigned to the polygon.
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Figure 5-46.  You can select polygons after they are drawn and assign materials to them.

5.10.2.  Access the Properties for Selected Polygon(s) dialog box:

Another way to assign a material to a polygon is to double-click on the polygon you want to change, or, if the
polygon is already selected, press Enter, use the Library/Set Material menu choice, or press F4. This causes
the Properties for Selected Polygon(s) dialog box to appear, as shown in the following figure.

Double-click (or
press Enter) on a
polygon, and the
Properties for
Selected
Polygon(s) dialog
box will appear.

Figure 5-47.  Material properties for solid material are accessed by double-clicking mouse on polygon.

The advantage of this method is that you can access the Material Library by using the Library button if you
want to add a new material or change the properties of a material.
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The information displayed in the Properties of Selected Materials dialog box is dependent on the type of
material, which is discussed in more detail in Section 5.11, "Defining New Materials." However, all material
types will have the following fields:

• Material:  a pull-down list, which shows the currently defined material for the selected polygon. With
this pull-down list, you can change the material for the selected polygon. This list contains the same
choices as the list on the right side of the toolbar.

• ID:  a field below the Material pull-down list, which is a unique number that is assigned to every
polygon in the cross section. This number is useful for identifying specific objects in the THERM
reports and when using the Select Special feature (discussed in Section 5.6).

5.10.3.  Solid Materials

For solid materials, the Material name and ID number are the only values displayed; however, if you press
the Library button, you can access the Material Definitions dialog box for that material and see the
Conductivity and Emissivity.

Click the left
mouse button on
Library and the
Material
Definitions dialog
box will open,
displaying the
Conductivity and
Emissivity values
for the solid.

Figure 5-48.  Material Definitions dialog box accessed from the Library button shows the Conductivity and Emissivity for
Solids.

5.10.4.  Frame Cavities

For cavities, several values are listed in addition to the material name and ID number:

� Keff, the effective conductivity, and Nu, the Nusselt number, which are calculated by THERM based on
the model choices specified in the Material Library and cannot be edited.

� The Vertical and Horizontal dimensions are the actual dimensions of a rectangular cavity or the effective
dimension determined by the Cavity Model selected in the Material Library for nonrectangular cavities.
These values can only be edited if the User Dimensions Cavity Model is selected.
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� The Heat Flow Direction can be selected from a pull-down menu. The three choices are Horizontal, Up
and Down. This choice determines what correlation will be used to calculate the convective film
coefficient. Horizontal heat flux assumes that the governing temperature difference is between the
vertical walls of the cavity. Heat flow Up assumes that the governing temperature difference is between
the horizontal walls of the cavity and that the lower wall is warmer than the upper wall. Heat flow Down
assumes that the governing temperature difference is between the horizontal walls of the cavity and that
the upper wall is warmer than the lower wall.

� The Temperatures are used to calculate the convective film coefficient in all cavity models and the
radiative conductance in the simplified radiation model. For horizontal heat flow these would be the
average temperatures of the vertical sides of the cavity. These values can be edited.

� The Emissivities appear for the simplified radiation model only. These are the emissivities of the surfaces
perpendicular to the heat flow direction, i.e., the vertical sides of the cavity for horizontal heat flow.
These values can be edited either by selecting a predefined value from the pull-down menu or by typing
in a value.

See Section 5.11, "Defining New Materials" for a more detailed explanation of how to use this information.

Double click on a
cavity polygon to see
the Properties dialog
box

Figure 5-49.  Material properties for cavities accessed by double-clicking mouse on polygon.

5.11.  Defining New Materials
There are four material types in THERM:

• Solid

• Frame Cavity

• Glazing Cavity (not currently implemented)

• External Radiation Enclosure.

THERM comes with a set of predefined materials that cannot be edited (the input values are disabled).
Materials can be added to the Material Library using the following technique.

1. Open the Material Library by selecting the Library/Material Library menu choice, and the Material
Definitions dialog box is displayed.  You can use the pull-down list at the top of Material
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Definitions to view the characteristics of any of the materials, but because the predefined materials
are protected from editing (they are grayed out), you cannot change any of the values, as shown in
Figure 5-50.  However, you can make new materials in this library, as explained in the following
steps.

Figure 5-50.  The default Material Library that comes with THERM has only "Protected" materials that cannot be edited.

2. To make a new material, click on the New button.

3. You will be asked for the name of the new material. Type a name that is not already in the library,
and click on the OK button.

Figure 5-51.  Type a unique name for the new material.

4. Now you are presented with the same Material Definitions dialog box, but all the fields are available
for you to edit. Different fields are available for editing depending on the Material Type that you
choose, i.e., solid, cavity, or external radiation enclosure.  These different types are discussed in detail
in the following sections.  Enter the input values as appropriate.

5. Click on the Color button to select a color for your material other than the default blue.

6. When you have defined the characteristics of the material, click on the Save Lib As button in order to
save the material permanently to the default library (named material.lib) so that it can be used again.
(If you forget to save it, you will be asked when you close THERM if you want to save the changes
you made to the library unless you turn this feature off using Options/Preferences/Prompt for
saving libraries on program exit).  See the discussion in Section 5.11.5, "Making Custom Material
Libraries" for details about having material libraries other than the default.
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Figure 5-52.  To define a new material, click on the New button; a nonprotected Materials Definition dialog box will appear,
allowing you to define the characteristics of the new material.

5.11.1.  Solid Materials Type

For the Solid material type, the relevant input values are found in the Solid Properties group box on the
Material Definitions dialog box, which contains the following values:

Conductivity Units: W/m-K (SI); Btu/h-ft-oF (IP)

Emissivity Default value:  0.9

Figure 5-53.  Material Library definition for solids

For the predefined materials, these values are not editable. However, if you click on the New button and
make a new material, you will be able to edit these values, as discussed previously in Section 5.11, "Defining
New Materials".
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5.11.2.  Frame Cavity

There are two materials in the default THERM library defined with the Material Type of Frame Cavity. These
materials have the following characteristics (the Radiation and Cavity Model definitions are discussed at the
end of this section):

� Frame Cavity (NFRC Simplified): Radiation Model:  Simplified

Cavity Model:  NFRC

� Frame Cavity (NFRC Detailed): Radiation Model:  Detailed

Cavity Model:  NFRC.

Figure 5-54.  Default Frame Cavity (NFRC Simplified) protected Material Library

If you want to make new frame cavities, follow the instructions above for making new materials; specify the
new input values in the Cavity Properties group box in the Material Definitions dialog box.  It is not
necessary to create a new material for each frame cavity. The following discussion explains the values needed
for many of these inputs.
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Figure 5-55.  Creating a new frame cavity entry in the Material Library

For a frame cavity material, you need to specify the type of Radiation Model and Cavity Model the program
should use. The most common case for NFRC compliance will be the Simplified Radiation Model and the
NFRC Cavity Model.

Radiation Model The radiation model to be used by THERM.

� Simplified:  uses the method in ASHRAE SPC 142P(16), modeling radiation effects as
an effective conductance based on the temperature and emissivity of the two
parallel faces perpendicular to the heat flow.  For nonrectangular cavities, this
conductance is determined using the dimensions of the approximate rectangle in the
Cavity Model (see below) and a curve fit model.  The default values for the
temperatures in the frame cavity are 7 °C and –4 °C.  The default emissivities are
0.90 for both surfaces.  The temperatures and emissivities of each frame cavity can
be edited in the Properties for Selected Polygons dialog box, which you can access
by double-clicking on the cavity.

� Detailed:  does an element-by-element view-factor calculation taking into account
the temperature and emissivity of each element; these THERM algorithms are based
on FACET(12).  The detailed model reads the emissivity of the surrounding material
from the material library.  These emissivities can be overridden by double-clicking
on the red boundary that appears around the cavities once the boundary conditions
have been defined. For more discussion about the detailed model, see Section 6.5.1,
"Frame Cavities with Detailed Radiation Model" and Appendix C, "Theoretical
Background."

Cavity Model The cavity model to be used by THERM. This model accounts for convection as well as
the way the nonrectangular cavities are approximated.

� NFRC:  In this model, the effective conductivity is calculated based on a rectangle
that fully encloses the cavity. Convection correlations are based on the Handbook of
Heat Transfer Fundamentals(11);; the specific correlations used can be found in
ASHRAE SPC 142P(16).

� CEN (unventilated):  This model calculates the effective conductivity based on a
rectangle with the same aspect ratio and area as the cavity being analyzed. This is a
European standard. When this Cavity Model is used with the Simplified Radiation
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Model, THERM uses the CEN version of the radiation model, which is slightly
different than the SPC 142 method.

� CEN (slightly ventilated):  This model is also part of the European standard.  It is to
be used for cavities that have an opening to the environment of greater than 2 mm
and less than 10 mm.

� User dimension:  In this model, the user can define the rectangular dimensions for a
nonrectangular shape; the effective conductivity is based on the SPC 142P method.

The effective conductance of frame cavities is obtained from standard correlations(11).  The material Frame
Cavity NFRC (Standard) assumes a horizontal heat flow.  For a rectangular cavity, the governing
temperature difference is assumed to be between the vertical walls of the cavity. An average emissivity for
these surfaces needs to be determined.  Horizontal heat flux assumes that the governing temperature
difference is between the vertical walls of the cavity. Heat flow Up assumes that the governing temperature
difference is between the horizontal walls of the cavity and that the lower wall is warmer than the upper wall.
Heat flow Down assumes that the governing temperature difference is between the horizontal walls of the
cavity and that the upper wall is warmer than the lower wall.  When drawing window models, take care that
the heat flow in the cavities is defined according to the conditions that will apply when the cross section is
positioned in the window.  In some cases, the vertical and horizontal dimensions will have to be switched (or
the cross section rotated) for these definitions to be correct.

After a polygon has been assigned a frame cavity material, you can view the cavity dimensions as well as the
effective conductivity and Nusselt number of the cavity by double clicking on the polygon. (This is discussed
in more detail in Section 5.10, "Assigning Materials After Drawing Polygons.")

5.11.3.  Glazing Cavity

This material type is not currently being used. Glazing cavity properties should be obtained from WINDOW,
which occurs automatically when you use imported glazing systems.

5.11.4.  External Radiation Enclosures

The external radiation enclosure feature uses the detailed radiation view-factor model to accurately simulate
the radiant exchange between the building component being analyzed and its surroundings.  This radiation
view-factor model takes into account the extent to which the component “sees” or radiates to itself.  In
thermal modeling of fenestration products, radiation accounts for half of the heat loss on the room-side
surface.  The simplified method assumes that the component only has radiant exchange with its
surroundings.  This assumption does not hold true for projecting fenestration products such as greenhouse
windows and skylights and may also be problematic for sliding windows with deep channels.

The radiation enclosure is one of the standard classes of material included in the material library.  Radiation
enclosures are bounded by the model and by boundary conditions of specified temperature.  Radiation
enclosures are unique because every point on the bounding surface of the model must be included in the
radiation enclosure.  (For all other materials, THERM can add any missing points.)  It is possible to draw the
radiation enclosure by hand, making sure a vertex exists on the radiation enclosure polygon for every vertex
on the adjacent polygon. The fill void feature, however, can simplify this procedure.   The following steps
explain how to use this feature to create radiation enclosures:

1. Draw a temporary polygon that surrounds the outside of the radiation enclosure.
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Step 1: Draw a polygon
that surrounds the area of
the radiation enclosure.

Figure 5-56. Draw a temporary polygon around the area that will become the External Radiation Enclosure.

2. Click on the Fill Void icon on the toolbar.

3. Place the Fill Void cursor inside the undefined area surrounded by the temporary polygon, and click the
left mouse button. The fill void feature will create a polygon with points defined that match the points on
all adjacent polygons.

Step 1: Click on the
Fill Void toolbar
button

Step 2: Place the Fill
Void mouse cursor inside
the area you want to fill
with the radiation
enclosure, and click your
left mouse button. The
cavity will be
automatically filled.

Figure 5-57.  Use the Fill Void toolbar button to create the External Radiation Enclosure polygon.

4. Select the polygon that is created by using a single click of the left mouse button, as shown in Figure 5-58.
Assign the material of the radiation enclosure polygon from the Materials pull-down list on the right side
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of the toolbar, or from the Libraries/Material Library menu choice. Select the predefined material in the
Material Library called Radiation Enclosure which has the Material Type of External Radiation
Enclosure, shown in Figure 5-59. Any material of this type will have special boundary conditions
automatically assigned to it; these are called Radiation Surface. See Chapter 6, "Defining Boundary
Conditions" and Section 7, "Calculating Results" for more information about External Radiation
Enclosures.

Step 1: Select the newly
created Radiation
Enclosure polygon.

Step 2: Select the predefined
Radiation Enclosure entry
from the Materials pulldown
list.

THERM will automatically
create points at the
intersection between the
radiation enclosure and the
adjacent polygons.

Figure 5-58.  Assign the predefined material Radiation Enclosure to the Radiation Enclosure polygon.

Figure 5-59.  The predefined Radiation Enclosure material can be used for the External Radiation Enclosure polygons

5. Delete the temporary polygon used to surround the radiation enclosure.  If a radiation enclosure is
completely surrounded by other materials (either solids or cavities), it will be considered a void in the
model. This is an incorrect use of the radiation enclosure feature; instead use the detailed frame cavity
model for cavities surrounded by other materials.
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The final Radiation
Enclosure, with the
temporary polygons deleted,
and the Radiation
Enclosure material
assigned.

Figure 5-60.  The completed Radiation Enclosure (the temporary surrounding rectangle deleted).

6. Complete the analysis by defining boundary conditions (see Section 6.5.2, "External Radiation
Enclosures" for special information about boundary conditions for this situation) and calculating the
results (see Chapter 7).

5.11.5.  Making Custom Material Libraries

The default THERM library is called "material.lib" and is located in the THERM installation directory.  The
default library can be customized by adding new material entries, or other custom material libraries can be
created, using different names and different directories if desired. Use the Save Lib As button in the Material
Definition dialog box to create custom libraries and load them using the Load Library button in the same
dialog box.

Step 1: Click on the
Save Lib As button.

Step 2: In the Save As dialog box, type
a  name for the new library. You can
change the directory where the library
will be located.

If you want to
load a custom
library, click on
the Load Lib
button.

Figure 5-61.  Material properties for cavities accessed by double-clicking mouse on polygon.
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5.12.  Creating a Component Library

In modeling windows, you will probably find that there are some components you need to draw again and
again.  THERM allows you save these frequently used components as separate files from which you can copy
and paste.  This is useful when the separate components that make up a window cross section are provided
as separate drawings.  It is also useful for drawing small, finely detailed objects, such as spacers.

Figure 5-62.  THERM file containing just a spacer

To cut and paste components between THERM files:

1. Open both a current working THERM file and the THERM file containing a component you wish to copy
and paste.

2. In the working file, place the locator (Shift F2) on the point where the matching point on the component
will be placed.

3. Use the Window menu to switch to the component file, and select the portions of the component that you
wish to copy and paste into the working file. A single THERM file, for instance, could contain all the
spacers from a single manufacturer. Use the Edit/Select All menu to include all the features in the
component file, or use the other polygon selection methods to select specific elements of the component
(see Section 5.6.1, "Selecting a Polygon" for more details.)

4. Place the locator (use Shift F2 and click the left mouse button) at the point which will match the location
in the working file.

5. Press Ctrl-C to copy the selected polygons into the Windows™ clipboard.

6. Using the Window menu, switch to the working file.

7. Press Ctrl-V to paste the selected polygons into the working file. THERM will position the pasted
polygons into the working file by matching the positions of the locator points defined earlier for the
component file and the working file.

5.13.  Importing a FRAMETM F30(3) File
THERM can import FRAMETM F30(3) files.  The program brings these files in as rectangles. In order to perform
a calculation on a FRAMETM F30 file, insert a glazing system, and assign materials, boundary conditions, and
U-factor tags.  F30 files are created for use with a finite-difference program and are limited to rectangularized
geometry, and are limited in the number of available rectangles used to define a cross section, often resulting
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in over simplification of cross sections. In addition, cavities which have been divided up into rectangles must
be redrawn in THERM.  THERM is a finite-element program that allows for geometry to be represented by
general polygons.  Use of F30 file is recommended for comparison purposes only.

Check the THERM website (go to the "Software" section of windows.lbl.gov) for updates about FRAME file
conversions.


